Active WebCam
Software Manual

The following manual contains instructions for use of your Active WebCam software. Most common support questions can be answered using this manual.
Table of Contents

CHAPTER 1 ....................................................................................................................................6

About Active WebCam.................................................................................................................. 6

System Requirements................................................................................................................ 7

Installing the program................................................................................................................. 7

Uninstalling the program ........................................................................................................... 7

Connecting Devices...................................................................................................................... 8

Installing Capture Card or Frame Grabber................................................................................. 8

USB Camera............................................................................................................................... 9

IP Camera.................................................................................................................................... 9

Program's Folder Structure...................................................................................................... 9

Loading the Program ................................................................................................................ 10

About the Program's Window.................................................................................................. 10

Tips for the Program's Window.............................................................................................. 11

Program Options....................................................................................................................... 11

Logs............................................................................................................................................... 13

Watchdog................................................................................................................................... 13

Checking for Upgrade.............................................................................................................. 14

CHAPTER 2 .................................................................................................................................. 15

Setting up Session..................................................................................................................... 15

Setting up Camera...................................................................................................................... 15

Camera Setting dialog box....................................................................................................... 16

Local Video and Audio devices ............................................................................................. 16

Network Cameras....................................................................................................................... 16

Remote Cameras......................................................................................................................... 17

Cycle through local video devices.......................................................................................... 18

Setting Quality of Recording and Broadcasting.................................................................... 18

Video Quality............................................................................................................................. 18

Sound Quality............................................................................................................................ 19

Scale, Crop, and Rotate Image ................................................................................................ 19

Scale Image................................................................................................................................. 19

Copyright PY Software, www.pysoft.com
Crop Image ................................................................. 19
Rotate Image ............................................................ 19

Captions on Image ....................................................... 20
Text Captions .............................................................. 20
Time formatting macros .............................................. 21
Special wildcards: ...................................................... 21
Image Captions .......................................................... 22
Rectangles ................................................................. 22

Broadcasting .............................................................. 22
Stream to Web Server ................................................ 23
Remote Access .......................................................... 24
Remote Access using own HTTP Server ...................... 25
Upload Images to FTP server ..................................... 27
FTP parameters ......................................................... 27
Saving Frames into other Folder .................................. 28

Watching Broadcasting ............................................... 29
Web Page Creation Wizard ........................................ 29
HTML code to show camera on own web page .......... 30
Java Applet Parameters ............................................. 31
Displaying Still Images on Web Page ......................... 32
Watching camera on PDA or Cell Phone ...................... 32

Motion Detection ....................................................... 32
Motion Detection Parameters .................................... 33
Motion Actions ......................................................... 34

Schedule Events ....................................................... 37

Recording Video ....................................................... 38
Recording Video Clip ................................................ 38
Customizing Recording .......................................... 38
Live Recording ......................................................... 39
Archive Recording ................................................... 39
How to play back video files from within Web Page .... 40
Creating Archive of Snapshots .................................. 41

Managing Program from Command-line ..................... 42

PY Software Web Services .......................................... 43
Streaming Video through Web Server ....................... 44
Dynamic IP Service .................................................. 44

Dial-Up Internet Connection ................................. 45
Chapter 1
Introducing the Active WebCam Surveillance System

About Active WebCam

Active WebCam captures images up to 30 frames per second from any video device including USB cameras, Analog cameras connected to capture card, TV-boards, camcorders with FireWire (IEEE 1394) interface and from Network cameras. The program broadcasts captured live audio and video content in real time to client computers either from your computer or through any FTP server.

Viewers can watch real video and audio using or Internet browser, or another copy of the Active WebCam program.

When the program detects motion in the monitored area, it can sound an alarm, e-mail you the captured images, and start broadcasting or record a video.

The program has features to add text captions and image logos to the images, to place a date/time stamp on each video frame, and to adjust the frame rate, picture size, and quality.

Ways to Use:

Banking
Financial institutions can install PY Software surveillance solutions at offices to increase security. Separate video files of each specific action can be stored onto a central Web server for potential future investigation. High image quality leads to easy identification of people and at the cashier in the branch office. Ability to encrypt video files gives additional proof of identity.

Buildings, offices, shopping-malls and parking lots
PY Software surveillance solutions can monitor buildings, offices, shopping-malls and parking lots securely and easily, thus making these places safer for all visitors. At night, surveillance system can be used to monitor the facility. In the event of an unauthorized entry, motion detection can initiate recording of the intruder and send an immediate notification to security.

Retail
PY Software surveillance solutions provide additional security over traditional analog systems for retail stores who are constantly exposed to the threat of robbery. Live video is transmitted over Internet and can be stored on a web server in a secure place, rather than on a tape cassette that is reachable by potential criminals.

Home security
During the day, you can watch your children, parents, pets etc. remotely through Internet. At night, motion detection can trigger an alarm, start recording video, and scare off intruders with a sound siren.
System Requirements

The program needs the following computer configuration to run:

- Intel® Pentium® 1 GHz or better;
- 256MB RAM;
- 1GB free disk space;
- Microsoft Windows;
- A frame grabber with video source (camera, VCR, etc.), or USB camera, or Network camera.
- A mouse;
- A color monitor.

Installing the program

On the computer's screen click Start, then Run and execute the Active WebCam installation file.

If you would like to install the software in a different directory, you can click the Browse button to change the installation folder. Click the Install button to continue installation.

When the installation is completed, a group named PY Software would be created in Programs under the Start menu.

Uninstalling the program

To remove the program from your computer:

- Click Start, Programs then PY Software and click on Active WebCam Uninstall.
Connecting Devices

Installing Capture Card or Frame Grabber

Please follow the following steps to properly install and configure your capture card:

- Run the BtInstaller.exe installation utility.
- When prompted, select the "Uninstall any previously installed driver" option. The installation utility will search your system for any Bt8x8 drivers and delete them.
- Turn Off computer.
- Install the capture card inside computer.
- Turn On computer.
- Windows detects there is new card and pop-ups the "Found New Hardware Wizard" window. Click the "Cancel" button in this window.
- Run the BtInstaller.exe installation utility again.
- Select the "Install" option.
- Select "Generic Bt8xx with 4 Composite ins" when asked for a card type.
- Select "No TV functions" in the TV Tuner list.
- Finish the installation.
- Restart computer and verify there are at least two items are shown as correctly installed in your "Control Panel", in the "System Properties", in the "Device Manager", under the "Sound, video and game controllers".
- Conexant's BtPCI WDM Video Capture
- Conexant's BtPCI WDM Audio Capture
- Run the Active WebCam program.
- Select Search Cameras from the File menu.

The program searches cameras connected to your computer and displays each camera in separate window.

**USB Camera**

To connect a USB camera to your computer:
- Install software which comes with camera.
- After rebooting your computer, connect camera to USB Port on your computer.
- Windows shows notification New Hardware Found and "Hardware Wizard" installs drivers for newly added hardware.
- If "Hardware Wizard" cannot find drivers for this camera refer to the camera manual for additional information.
- Run the Active WebCam program.
- Select Search Cameras from the File menu.

The program searches cameras connected to your computer and displays each camera in separate window.

**IP Camera**

To connect to an IP camera:
- Run the Active WebCam program.
- Click New Camera from the File menu.
- Camera Setting dialog box appears.
- Follow instructions at the Network Cameras topic (page 16) to properly install and configure your IP camera.

**Program's Folder Structure**

The program's folder contains all the files you need to use Active WebCam.

Do not move or rename the Active WebCam folder or any folders within it. If you need to relocate the Active WebCam folder, you must uninstall and reinstall the program.

Active WebCam performs best when the application and its parts remain in the folder recommended during installation. This is especially true with the `Gallery` folder.

If you change folder names and/or locations using Windows Explorer or File Manager, Active WebCam might not be able to track files and links properly.

The sub folders organize files according to their use:
- `\Gallery` contains captured pictures, which you create with the Take a Picture command.
• \Help contains help files.
• \Images is used in the \Web Cam HTTP server publishing method.
• \Logs contains log files.
• \NetCams Models contains configuration files for various types of Network cameras.
• \Page Templates contains templates for Web Page Creation Wizard.

Loading the Program

To load Active WebCam:
On the Window's Start menu, click Programs, then PY Software, then Active WebCam.
When Active WebCam initially loads, it doesn't connect to any camera. You need to connect camera manually by clicking New Camera from the File menu.

About the Program's Window

The Active WebCam work area contains some panels that you can show or hide to get a more comfortable working place. Here are some of the most used components:

• The Camera Window is used to control and preview camera. It has button bar to operate with Live Recording.
• Camera Thumbnails are used to select a camera and show or hide it.
• The Information Panel displays useful information about the camera state.
• The Log Panel collects a history about events and errors. It helps to troubleshoot a broadcasting process. This information can be printed or saved to a file.
• The **Viewers Panel** collects a history about viewers IP addresses and node names. This information can be printed or saved to a file.

• The **Gallery Panel** shows small images of recorded files and snapshots in the Gallery folder. Click with right mouse button to an image to get a context menu for the appropriated file.

To open a panel, use the **View** menu. A check mark next to an item indicates that the named item is currently open. To display an item that isn't currently open, choose the item name from the menu.

### Tips for the Program's Window

**Right-Click Context Menus**

Right-clicking on an item, such as panel, grid, etc., opens a context menu which includes basic editing controls (e.g., Copy, Paste, or Modify).

**Menus**

All menu items have keyboard "access keys" (underlined letter in menu option). To open main menus, access keys use **ALT+letter** (e.g., File menu = ALT+F). To open an option on a menu, press only the access key (letter).

**Help Window**

To open a Help window select **Contents** from the **Help** menu or press the **F1** key.

### Program Options

Active WebCam has options that control the general appearance of user interface as well as options related to specific features.

**To change Active WebCam options**

- Select **Program Settings** from the **Settings** menu. The **Program Options** dialog box appears.
- Set desired options.
- Press **Ok**.

The **Program Options** dialog box fields:

Click to select **Open Session at Startup** if you want the program to open a previously saved session at start-up.

If you select **Session File Name**, the program will always open the specified session.

If you select **Last Saved Session**, the program will open a recently saved session.
Click to select **Start on Windows Startup** if you want that a shortcut to the program will be created in Windows's **Startup** menu. It forces to run the program every time when Windows start up.

If **Start as Service is selected**, the program starts automatically at system boot and executes even when no user is logged on to the system (this feature is not available under Windows 95, 98, and ME).

You might need to be logged on as an administrator or a member of the Administrators group in order to manage the services on your computer. To open Services manager, click Start, point to Settings, and then click Control Panel. Double-click Administrative Tools, and then double-click Services.

For information about using Services, click Help on the Action menu in Services.

Click to select **Run Minimized** if you want the program to be in minimized state after start.

Click to select **Minimize to Task Tray** if you want the program not to be presented in task bar when you click the minimize button.

The program displays an icon in the sys tool tray at the bottom right of your screen.

This icon helps you to operate with the minimized program:

- Click right mouse button on the icon to display a popup menu.
- To show the Main window again, double click the icon with the left mouse button.

To have the program completely invisible when it minimized, click to select **"Stealth" mode when minimized**. In this mode the program doesn't display any icon in the sys tool tray and it is not presented in the task bar tray. To make hidden program visible run the program again. This new started process sends hidden program a message to show up and be visible.

Click to select **Hide the "Stealth Mode" Warning Box** to force the program not to show a notification window when it's going to "Stealth Mode".

Click to select **Protect from Opening from Task Tray or from "Stealth" mode with Password** if you want the program to ask for password when a user clicks icon in the sys tool tray.
**Logs**

Click to select **Log HTTP viewers to the "HTTP_Log.txt" file** to cause program to write viewers's IP addresses to the log file.

Click to select **Log motion events to the "Motion_Log.txt" file** to cause program to save motion information to the log file.

Click to select **Log Program Events to the "Events_Log.txt" file** to cause program to save alerts to this file.

---

**Watchdog**

Watchdog is small software, launched by the program that monitors and automatically reboots the program if it's locked-up.

**To enable Watchdog:**

- Select **Program Settings** from the **Settings** menu.
  
  The **Program Options** dialog box appears.

- Select the **Watchdog** tab.

- Click to select the **Watchdog Enabled** check box.

If the program does not respond for a specified number of consecutive polls, it can be restarted.

To monitor and restart a frozen program click to select the **Restart the program if no response** check box.

If Watchdog attempts to restart the program and it fails to restart for a specified number of consecutive attempts, the operating system can be restarted.

To restart the computer if this frozen program cannot be restarted click to select the **Reboot the computer if the program fails to restart** check box.

If computer works less stable in time the operating system can be restarted periodically by this watchdog.

To configure Watchdog to reboot the computer periodically, click to select the **Reboot the computer periodically** check box and select a period. The computer can be rebooted **hourly, daily, weekly or monthly**.

If the program uses too much CPU time for a specified number of consecutive polls, it can be restarted.

To configure Watchdog to restart the computer if CPU usage too high, click to select the **Reboot the computer if CPU usage exceeds** check box and select maximum CPU usage value and time period specified in polls.
Checking for Upgrade

The checking for upgrade informs you about new version of Active WebCam. It queries the PY Software server for upgrade information using an internet connection. A dialog box will appear to tell you if an update is available. You need to establish an Internet connection the checking for upgrade can work.

The program is reading information only; it doesn't send anything to the server.

To switch on the Upgrade notification

Click to select the Checking for Upgrade item from the Tools menu. Active WebCam will periodically (every 14th day) contacts PY Software server in the background to determine if a newer version is available. If an upgrade is available, Active WebCam offers to download the new files.

To check for upgrade immediately

Click the Check for Upgrade Right Now item from the Tools menu. Active WebCam Immediately contacts PY Software server and notifies you if an upgrade is available.
Chapter 2

User Guide

Setting up Session

Information about cameras you have created can be stored to a file with .AWSes extension so that you can open and reuse the session at a later date.

A session file contains information about video and audio devices, compression, broadcasting, and recording parameters of every camera.

To save a session

- Click **Save Session As** from the **File** menu.
- In the **File name** box, enter a name and location for the file, and then click **Save**.

To open an existing session

- Click **Open a Session** from the **File** menu.
- In the **File name** box, enter the name and location of the session file you want to open. Session files have the .AWSes extension.
- Click **Open**.

Setting up Camera

The program works with many video sources simultaneously. Every video source represented by Camera Window. A Camera Window can be connected to a Local camera (frame grabber or USB camera), Network camera (Axis®, D-Link®, etc.), or to Remote camera (another Active WebCam program launched on remote computer with video capture device).

To create new Camera Window

- Click **New Camera** from the **File** menu.
  
  **Camera Setting** dialog box appears.
Camera Setting dialog box

Camera Setting dialog box helps you control selected video source. To open the Camera Settings dialog box, select Camera Settings from the File menu.

Set a preview rate in the Preview Frame Rate box. It indicates preview speed in the number of frames per second in the camera window. The default value is 10 frames per second. This value doesn't interfere with broadcast or record frame rate.

Local Video and Audio devices

Click to select Local Camera if you want to work with video device connected directly to this computer.

Capture Method

The Capture Method radio buttons allow you to select a method of video capture, which your camera is supported:

Video for Windows (VfW) was released for the Windows 3.1 operating system and was optimized for capturing movies to disk. Since then, video capture rates have risen dramatically because of the use of the PCI bus, bus mastering controllers, and direct transfer of captured video from adapter memory to disk without data copies.

Direct Show video capture was designed to resolve the problems inherent in the VfW architecture. It provides 32-bit drivers for devices with a 32-bit architecture, such as USB and IEEE 1394 conferencing cameras and supports multiple streams.

Video Device

Choose a camera to work with, from the Video Devices drop-down list.

The camera control buttons set depends on type of camera. For USB cameras it is mostly the Video Capture Filter and Video Capture Pin buttons. The Video Capture Filter button helps to change image characteristics, like brightness, contrast, sharpness etc. The Video Capture Pin button allows setting image size and color mode.

Network Cameras

Network cameras are devices in local network or in Internet that are answer with JPEG image by HTTP request.

To connect to Network Camera:

- Click to select the Network IP Camera radio button. Select the network camera type from the Camera Model drop-down list. If your camera is not presented in this list, select Unknown.
- In the IP Address box type the network address of your camera. Don't place the protocol prefix (like http://) in the IP address box, just four digits of IP address delimited by dots, like: 192.168.1.101. If
your network camera has dynamic IP address, you can find the camera address in the DHCP table of your network router.

- If network camera requires user name and password, type these values in the User ID and Password boxes.
- Click the Connect to the Camera button.
- Click Ok.

**To configure network camera**

The Camera Interface button helps to select the camera model and set up command strings, which are used for image requests.

Click the Camera Interface button.

In the String to request JPEG image box type command to read image from camera. For example: http://{USER_ID}:{PASSWORD}@{CAMERA_IP}/cgi-bin/video.jpg

The program uses the following abbreviation to replace parameters in the interface strings:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{CAMERA_IP}</td>
<td>Replaces camera's IP address and IP port, for example: 192.168.1.101:8080</td>
</tr>
<tr>
<td>{USER_ID}</td>
<td>Replaces user name entered in the User ID box.</td>
</tr>
<tr>
<td>{PASSWORD}</td>
<td>Replaces password entered in the Password box.</td>
</tr>
<tr>
<td>{&lt;BASE64&gt;USER_ID}</td>
<td>Encodes using &quot;Base64&quot; encoding and replaces user name entered in the User ID box.</td>
</tr>
<tr>
<td>{&lt;BASE64&gt;Password}</td>
<td>Encodes using &quot;Base64&quot; encoding and replaces password entered in the Password box.</td>
</tr>
<tr>
<td>{FPS}</td>
<td>Replaces with frame rate in frames per second</td>
</tr>
<tr>
<td>{FRAMEDURATION}</td>
<td>Replaces with frame duration in milliseconds</td>
</tr>
</tbody>
</table>

The Control Camera button shows dialog box with controls that are enabled for the particular model of network camera.

**Remote Cameras**

Remote camera is another Active WebCam program with activated Remote Access. Both programs use UDP protocol to communicate each other. If connection with remote camera goes through firewalls, make sure that the IP address of your computer, local and remote ports are opened on both firewalls, and on both firewalls the UDP protocol is enabled.

**To connect to Remote Camera**

In the Device tab click to select Remote Camera.

Specify the computer address in the IP address box. Don't place the protocol prefix (like http://) in the address, just four digits of IP address delimited by dots, like: 192.168.1.101. You can find out the remote computer's address by clicking Get Computer IP Address from the Tools menu on the remote computer.
In the **Remote Port** box type port to connect with on the remote computer. This value must be the same like value specified on the remote computer in the **Remote Port** box of the **Broadcasting** tab.

Specify port, which will be used to receive data from remote camera, in the **Local Port** box. If your network uses firewall, make sure that **Local Port** and computer's IP address are opened in the firewall.

Use the **Check the Port Availability** button to make sure that this port is not used by another program.

If the remote computer requires authorization, enter **user name** and **password** in the appropriate boxes.

To configure authorization click the **Additional Settings** button in the **Broadcasting** tab in the **Camera Settings** window on the remote computer.

If the **Remember Password** check box is checked, the user name and password will be saved among the session parameters.

**Cycle through local video devices**

If you have multiple cameras connected to computer you can set up a cycler to have the program to change cameras automatically.

**To configure the Camera Cycler:**
- Click **Camera Settings** from the **File** menu.
- Click to select the **Cycle through Video Devices** check box to activate cycler.
- Type cycler **Interval** in seconds.
- Select video devices to cycle.

**Setting Quality of Recording and Broadcasting**

The **Compression** tab of the **Camera Setting** dialog box allows you to set up image and sound quality by changing the compression level. These settings are used to prepare content for broadcasting and recording.

**Video Quality**

Higher Data Rate results more details in captured images but it needs more network bandwidth. Make sure that your Internet connection has enough upload speed.

**To change video quality**
- Click **Camera Settings** from the **File** menu.
- Select the **Compression** tab.
• Change value in the **Maximum Data Rate** box.

**Sound Quality**

More compressed sound has less bit rate and sampling frequency and as result pour quality.

**To change sound quality**

• Click **Camera Settings** from the **File** menu.
• Select the **Compression** tab.
• Change value in the **Sound Quality** box where 100% is highest quality.

**Scale, Crop, and Rotate Image**

**Scale Image**

Click to select the **Scale Image** check box to shrink or grow captured image. Set desired image size in per-cents of original image.

**Crop Image**

**Crop Image** allows selecting part of a captured image and discarding the rest.

To define cropping area, click to select the **Crop Image** check box. A resizable selection box appears over the image. Resize the selection as needed and then move it over the part of the image you want to keep. You can use Arrow keys to move rectangle or Shift + Arrows to resize.

**Rotate Image**

If your camera is ceiling mounted, you can have 180° rotated image by selecting the **180°** radio button.

Some cameras and frame grabbers allow producing cropped, scaled or rotated images. If these functions are performed "on board" it doesn't use computer CPU. Check the presenting of such features by clicking the **Video Capture Filter** button in the **Device** tab.
Captions on Image

The program has ability to place unlimited number of text, image and rectangular captions onto captured images. Text captions are providing some information on captured image, and/or data-time stamp. The image and rectangular captions allow you to decorate captured image.

The caption position can be specified in pixels or you can choose from the list of predefined positions like Top-Left, Top-Center etc. In this case the caption will stay at this position regardless of the image size.

To create new caption

- Select Caption from the Settings menu.
- Click the Captions tab in the Camera Setting dialog box.
- Click to select the Caption Enabled check box to cause Active WebCam draw caption on every captured image.
- Click appropriate button to add text, image, or rectangle caption.

Text Captions

To add text:

- Click the Add Text Caption button:
- In the Caption Text box, type a text caption.

If you want to insert a date and time in the caption, it must be enclosed in the braces {}. Like: {dd/mm/yyyy}.

For example the text:

Captured on {dd/mm/yyyy} at {hh:mm:ss}

will be displayed as:

Captured on 10/08/2001 at 22:13:30
Time formatting macros

You can use the following data/time placeholders to display current date and time in the text captions:

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Displays:</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>Displays the day as a number without a leading zero (1-31).</td>
</tr>
<tr>
<td>dd</td>
<td>Displays the day as a number with a leading zero (01-31).</td>
</tr>
<tr>
<td>ddd</td>
<td>Displays the day as an abbreviation (Sun-Sat).</td>
</tr>
<tr>
<td>dddd</td>
<td>Displays the day as a full name (Sunday-Saturday).</td>
</tr>
<tr>
<td>m</td>
<td>Displays the month as a number without a leading zero (1-12).</td>
</tr>
<tr>
<td>mm</td>
<td>Displays the month as a number with a leading zero (01-12).</td>
</tr>
<tr>
<td>mmm</td>
<td>Displays the month as an abbreviation (Jan-Dec).</td>
</tr>
<tr>
<td>mmmm</td>
<td>Displays the month as a full name (January-December).</td>
</tr>
<tr>
<td>yy</td>
<td>Displays the year as a two-digit number (00-99).</td>
</tr>
<tr>
<td>yyyy</td>
<td>Displays the year as a four-digit number (0000-9999).</td>
</tr>
<tr>
<td>h</td>
<td>Displays the hour without a leading zero (0-23).</td>
</tr>
<tr>
<td>hh</td>
<td>Displays the hour with a leading zero (00-23).</td>
</tr>
<tr>
<td>n</td>
<td>Displays the minute without a leading zero (0-59).</td>
</tr>
<tr>
<td>nn</td>
<td>Displays the minute with a leading zero (00-59).</td>
</tr>
<tr>
<td>s</td>
<td>Displays the second without a leading zero (0-59).</td>
</tr>
<tr>
<td>ss</td>
<td>Displays the second with a leading zero (00-59).</td>
</tr>
<tr>
<td>ts</td>
<td>Displays the tenth-second with a leading zero (00-09).</td>
</tr>
<tr>
<td>hs</td>
<td>Displays the hundredth-second with a leading zero (00-99).</td>
</tr>
<tr>
<td>ms</td>
<td>Displays the millisecond with a leading zero (000-999).</td>
</tr>
<tr>
<td>am/pm</td>
<td>Uses the 12-hour clock and displays 'am' for any hour before noon, and 'pm' for any hour after noon.</td>
</tr>
</tbody>
</table>

Special wildcards:

{CAMERA} - displays camera number.
{MOTION} - shows current value of motion.
{COUNTER} - a placeholder for counted value.
{VIDEODEVICE} - shows the video device name. This wildcard can be used to separate video records from different cameras when the Cycle through video devices option is active.
{IP_ADDR} - shows IP address of computer.
{EXTERNAL_IP_ADDR} - shows external IP address of computer. This is the address that the "outside world" sees.
Image Captions

To place an image overlay

- Click the **Add Image Caption** button:
- Set the image file by clicking the **Browse** button.
- Use appropriate controls to change the image **position**, **opacity**, and **transparency**.

Rectangles

The program allows you to place rectangular areas onto an image. You can set up the rectangle color and outline, as well as width, height, position, opacity, and transparency.

To draw a rectangle

- Click the **Add Rectangle Caption** button:
- Use appropriate controls to change the rectangle **size**, **position**, **opacity**, and **transparency**.

Broadcasting

The Broadcasting helps you share captured video and audio among Internet users or within a local area network.

**You can perform broadcasting by different ways:**

1. **Stream to Web server** - The program sends video and audio to the PY Software web server. Users connect to this web server and watch the camera.

2. **Remote Access** - other Active WebCam programs connect to the server program which captures video and audio from sources. Server uses UDP protocol to push captured images and sound to the viewer computers.

3. **HTTP Server** - the program runs HTTP server on this computer; viewers can connect to this computer by TCP/IP using any internet browser and see the web page with camera's live feed.

4. **FTP Upload** - the program uploads captured images to a web server using FTP protocol. Viewers point internet browsers to your web site and watch uploaded images.

To select the type of Broadcasting:

- Click **Broadcast Settings** from the **Settings** menu.
- Select the **Broadcasting** tab.
Click to select the appropriate check box.

**Stream to Web Server**

This service helps to access video on surveillance computer through Internet even if this computer completely protected by firewall. Surveillance computer connects to the PY Software web server like any other Internet browser does and firewall doesn't mention this connection as restricted.

The program sends video and audio to the PY Software web server that users can connect to this web server and watch the camera. Because PY Software web server has broadband connection, this method provides high frame-rate broadcasting to the unlimited auditory.

![Diagram of streaming video](image)

To use this broadcasting method you have to be subscribed on it.

Click the **PY Software web services** command from the **Tools** menu to subscribe for this service. See more information at the **Streaming Video through Web Server** topic (page 44).

**To activate Web Streaming**

- Make sure that you already signed up for PY Software account.
- Click **Broadcast Settings** from the **Settings** menu.
- Click to select the **Stream to Web server** check box.
- Set the streaming frame rate in the **Frame Rate** box.
Remote Access allows having video and audio on remote computer with very high quality and frame rate, but the opposite side is that viewers must use the Active WebCam program to access camera and camera computer must be visible from Internet (unlike the web streaming).

**To activate Remote Access**

- Click to select the **Remote Access** check box in the **Broadcasting** tab to enable access to this camera from other computers.

Another copy of Active WebCam should be run on remote computer in order to have Remote Access.

Set up the remote access **Frame Rate** and the UDP **Port** value. Active WebCam uses the Port value to receive requests from remote computers. The Port must be available - not used in other programs and it's not used by other cameras in Active WebCam.

Click the **Check the Port Availability** button to make sure the port it's not used by other programs.

If you want to have Remote Access to the camera from outside local network (from Internet), make sure that the port and IP address of your computer are opened in the firewall. See more info [how to configure your network router for remote access](#).

Click the **Additional Settings** button to configure Remote Access.

The content of remote access is managed by the **Enable Video Stream** and **Enable Audio Stream** buttons.

If you want to control number of remote clients, click to select the **Limit Viewers** check box and enter maximum number of viewers that can be connected to the camera. All over-limited viewers will receive message: "Administrator has limited the number of camera viewers. Please try again later."

Video and Audio data can be encrypted for security reason. Select the encryption type from the **Encrypt Transmitted Data** list.

You can restrict access to the camera by user name and password. Click to select the **Use Authorization** check box and click the **Add** button to grant access to this camera to a user or group. Only selected users and users belonged to selected groups have access to the camera. Viewers must enter valid name and password in order to connect to the camera.
Remote Access using own HTTP Server

Select the HTTP Server method if you want to have access from outside to camera and to recorded files. The software runs own HTTP Server that viewers can watch camera using any Internet Browser.

To watch camera, viewers type address and HTTP port of surveillance computer in the Internet browser, for example:

http://63.236.73.147:8080

In opposite to Remote Access, viewers don't need to use Active WebCam to connect to the surveillance computer. They use any Internet browser to watch captured images.

Disadvantage of this method is lower frame rate than using Remote Access or Web Streaming.

To activate HTTP server

- Click Broadcast Settings from the Settings menu.
- Click to select the HTTP Server check box.

How does WebCam HTTP Server work?

When a viewer types address and HTTP port of surveillance computer, the Internet Browser sends a request to surveillance computer to obtain default web page. This page contains java applet, which will be downloaded from surveillance computer too. Once the Internet browser downloads the applet, the applet executes and starts sending requests to surveillance computer for captured images. The applet sends requests according the frame-rate interval. When image received it is displayed in front of the previous image that makes illusion of real video.

What do you need to run WebCam HTTP Server

Your computer must be visible from Internet. If your computer behind firewall or proxie, you need to configure that device that your IP address and port you specified are not blocked.

If you plan to broadcast among computers in a Local Area Network (LAN), your computer and computers of all viewers must have IP protocol.

Configure HTTP Server

In the Frame Rate box enter how often you want the picture refreshes on viewer's computer. To avoid the "Off Line" color bars appearing on client's computer, set the Frame Rate equal to client's network bandwidth.

Port

Type the HTTP port number that is used for viewer requests listening. To connect to HTTP Server, viewers enter IP address and HTTP Port of surveillance computer in the Internet browser. For example: http://192.168.1.1:8080. Use the Get Computer IP Address command from the Tools menu to find out IP address of your computer.

Click the Additional Settings button to change extra parameters of HTTP server.

Image Name
The **Image Name** parameter is used on viewer's side to show captured images. If you change Image Name, be sure you've changed appropriate parameter in the default web page. For Java applet it is the **IMAGE** parameter. If your Web Page doesn't use Java applet, change the SRC parameter in the `<IMG>` tag.

See [Creating Web Page](#) for more info about Java applet parameters.

**Server Folder**

Type the folder name where you want to place default web page and java applet. Also captured images are saved to this folder that viewers can read them.

**Other folders that viewers have access**

You can open access to folder with video files and log files. Use the **Video Files and Snapshots** and **Event Logs** check boxes enable or disable access to these folders.

**Default Web Page**

Specify file name of default web page. This file must exist and must be placed into the **Server Folder**. When viewers enter IP address and HTTP Port of surveillance computer in the Internet browser they see this web page. Use the [Web Page Creation Wizard](#) to create this web page.

**Restrict Access to HTTP server**

Access to the surveillance computer can be restricted by user name and password. To restrict the access click to select the **Use Authorization** check box and click the **Add** button to grant access to this camera to a user or group. Only selected users and users belonged to selected groups have access to the camera. Viewers must enter valid name and password in order to connect to the camera.

**Limit Number of Viewers**

You can limit number of viewers if you want to minimize Internet traffic. To limit number of viewers click to select the **Limit Viewers** check box and enter maximum number of viewers in the **Max. Number of Viewers** box.
Upload Images to FTP server

Select the FTP Upload method if you want the program to upload captured images to your Web site using FTP protocol. To watch the captured images, you just need to point your Internet browser to your site.

The benefits of FTP use are: you don't need to have a permanent and fast internet connection (such as, Cable Modem, DSL, ISDN, etc.), and it's not necessary to make your computer to be accessible from Internet (security problems). An opposite side of FTP using is the lower frame-rate.

What is FTP?

FTP is an acronym for File Transfer Protocol. As the name implies, FTP is used to transfer files between computers on a network, such as the Internet. In an FTP transfer, your computer acts as a "client" sending a files to a remote host, or "server". Even computers from different manufacturers and running incompatible software can use this FTP process to exchange files over the Internet. To establish a connection to an FTP server, you generally need to provide a user name and a password in addition to the Internet address of the server (for example, hostname.berkeley.edu); someone would need to set up a user account and assign a password for you before you would be able to access the server.

To activate FTP Upload

- Click Broadcast Settings from the Settings menu.
- Click to select the FTP Upload check box.
- In the Frame Rate box enter how often you want to capture images. An image will be captured and broadcasted from your computer each time a specified time has passed. To avoid a CPU overload problem, set the Frame Rate equal to your network bandwidth.

FTP parameters

Click the FTP Settings button to set up FTP parameters.

Address of FTP server

Type name of FTP host of your Internet Service Provider (ISP), for example: ftp.microsoft.com or members.aol.com.

Please don't place the ftp:// or http:// prefix in the address. Contact your hosting company or Web server administrator to obtain address of your FTP server.

User Name

Type user (login) name for this FTP server. You have to receive this name when you subscribe for web hosting.

Password

Type your password for this FTP server. The password field replaces all typed characters with asterisks to hide it.
Folder to Upload
Type path to a folder where captured image and web page files will be uploaded. If you have no idea what this path looks like contact your hosting company or Web server administrator to obtain this information.

FTP Port
Specify port number, which is used for FTP service on your web site (if it's not 21 on your server). It may be different if you are going through a firewall, or if the site administrator has assigned the FTP service to a non-standard port.

Passive FTP
This option causes the program to use passive mode on FTP uploads. Some proxy servers require using this option.

Use Proxy
Specify if the program needs to use a proxy server to connect to FTP server. To list a proxy for a specific protocol, the string must follow the format:

<protocol>=<protocol>://<proxy_name>

The valid protocols are http, https, ftp, and gopher. For example, to list an ftp proxy, a valid string would be:

ftp=ftp://ftp_proxy_name:21

where ftp_proxy_name is the name of the ftp proxy and 21 is the port number that must be used to access the proxy. If the proxy uses the default port number for that protocol, the port number can be omitted.

Click the Additional Settings button to change extra FTP parameters.

Image Name
The program uploads captured images to FTP server under this name. If you change Image Name, be sure you've changed appropriate parameter in the webcam's web page. For Java applet it is the IMAGE parameter. If your Web Page doesn't use Java applet, change the SRC parameter in the <IMG> tag.

See Creating Web Page for more info about Java applet parameters.

Wait for response
The program waits for this time for an answer from FTP server. If there is no answer, it interrupts the FTP session and reconnects.

Disconnect after
If there was no activity during this time, the program disconnects from FTP server.

Image when WebCam is Offline
By default Active WebCam deletes the last captured image from FTP server when broadcasting are going to be stopped. If you want the program to replace last captured image with your own image (for example image with text: "I'll be back"), click to select the Upload Another Image to FTP Server check box and specify the image file name in the text box.

Saving Frames into other Folder
Select the Copy Captured Images method if you want Active WebCam to save captured images into a folder on your computer. You can broadcast the images using third party web server (for example Microsoft WWW Server) or use it for another purposes.

Type the folder name, where Active WebCam saves captured images, in the Folder box.

Don't forget to copy to this folder a web page with link to Active WebCam java script, and the java script file.
Click the Additional Settings button to change extra parameters.

**Image Name**

The Image Name parameter is used on viewer's side to show captured images. If you change Image Name, be sure you've changed appropriate parameter in the web page. For Java applet it is the IMAGE parameter. If your Web Page doesn't use Java applet, change the SRC parameter in the <IMG> tag.

See Creating Web Page for more info about Java applet parameters.

**Image when WebCam is Offline**

By default Active WebCam deletes the last captured image from the folder when broadcasting is going to be stopped. If you want the program to replace last captured image with your own image (for example image with text: "I'll be back"), click to select the Replace with Another Image check box and specify the image file name in the text box.

---

**Watching Broadcasting**

Different broadcasting methods require different techniques to watch them:

To watch the Stream to Web Server broadcasting, Internet browsers has to be pointed to an address like: http://yourname.web2cam.com, which is your personal page on the PY Software web server.

If the Remote Access is used, the Active WebCam program must be installed on the viewer's computer and new camera must be created with device type - Remote Camera. See more info about how to connect to the camera using remote access in the Remote Cameras topic (page: 17).

If the HTTP Server method is used, viewers type IP address and HTTP port of surveillance computer in the Internet browser (for example: http://63.236.73.147:8080).

If you want to connect to your camera from within local area network, open Internet Browser, and just type IP address of camera's computer and camera's port.

If you want to connect to your camera from outside local area network or from Internet, you have to know external IP address of your local area network, which can be defined at: http://www.whatismyip.com

Open Internet Browser, and type external IP address of surveillance computer and camera's port. If your network uses firewall, make sure that the port and IP address of camera's computer are open on the firewall. Please refer to the "router configuration" section in the frequently asked questions.

When viewers connect to HTTP server, it shows a "default" web page. This web page contains special code that is constantly downloads image from surveillance computer and simulates live video. See more info about how the HTTP Server works in the Remote Access using own HTTP Server topic (page: 25).

If the FTP Upload broadcasting method is used, viewers open camera's web page on a web server. This web server can be ordered from any web hosting company or from PY Software. Camera's web page must be created and uploaded to this web server. This page contains special code that is constantly downloads image from web server and simulates live video.

You can prepare the camera's web page using any HTML editor you like. Fortunately, Active WebCam has own tool to prepare simple camera's web page.

**Web Page Creation Wizard**

To open the Web Page Creation Wizard, select Create Web Page from the Tools menu.
Web Page Creation Wizard helps you to specify what cameras will be presented on the web page, web page's title, background color, text color, upper and lower captions.

If camera is watching through web server the Wizard uploads all page's files onto web server by FTP protocol.

**HTML code to show camera on own web page**

**Broadcasting method: Stream to Web server**

Insert the following code into your HTML page:

```html
<iframe src="http://YOUR_ID_HERE.web2cam.com/webpage.php?c=1&b=1&h=200&w=300&bg=EEEEEE"
    height="320" width="480">
</iframe>
```

Please use your login name instead of YOUR_ID_HERE in tag above. The only parameter you need is 'c', which indicates your camera number.

Parameters description:
- **w** - webcam picture width.
- **h** - webcam picture height.
- **bg** - background color. Default is blue color.
- **b** or **border** - show/hide frame border with buttons. (1/0 or ON/OFF)
- **v=java** - use Java Applet viewer instead of ActiveX (You need to activate Java Applet viewer first in your profile http://www.web2cam.com).

**Broadcasting method: HTTP Server**

To show Media Player insert the following code into your web page:

```html
<OBJECT Name="WMP1" WIDTH=320 HEIGHT=325 classid="CLSID:22d6f312-b0f6-11d0-94ab-0080c74c7e95"
    CODEBASE="http://activex.microsoft.com/activex/controls/mplayer/en/nsmp2inf.cab#Version=6,0,0,0"
    standby="Loading Microsoft Windows Media Player components..." type="application/x-oleobject">
    <PARAM NAME="FileName" VALUE="/STREAM.ASX?NAME=1">
    <PARAM NAME="ShowControls" VALUE="1">
    <PARAM NAME="ShowStatusBar" VALUE="1">
    <PARAM NAME="ShowDisplay" VALUE="0">
    <PARAM NAME="DefaultFrame" VALUE="Slide">
    <PARAM NAME="Autostart" VALUE="1">
    <PARAM NAME="DisplaySize" VALUE="0">
    <embed type="application/x-mplayer2"
        pluginspage="http://www.microsoft.com/Windows/MediaPlayer/download/default.asp"
        src="/STREAM.ASX?NAME=1"
        Name=WMP1 Autostart=1 ShowControls=1 ShowDisplay=0 ShowStatusBar=1 DefaultFrame="Slide"
        width=320 height=325>
</embed>
</OBJECT>
```

To show **Java Applet** add the following code to your HTML text:

```html
<APPLET CODE="WebCam_Viewer.class"
    WIDTH=640 HEIGHT=480>
    <PARAM NAME="COLOR" VALUE="#00FF00">
</APPLET>
```
Modify the COLOR parameter according to color of your web page.

Change the IMAGE parameter according to value in the Image Name box in the Internet Setting dialog box.

**Broadcasting method: FTP Upload**

Insert the following code into your web page to show Java Applet:

```html
<APPLET CODE="WebCam_Viewer.class"
WIDTH=640 HEIGHT=480>
  <PARAM NAME="COLOR" VALUE="#00FF00">
  <PARAM NAME="IMAGE" VALUE="capture0.jpg">
  <PARAM NAME="BORDER" VALUE="ON">
</APPLET>
```

Modify the COLOR parameter according to color of your web page.

Change the WIDTH and HEIGHT parameter according to image size.

Change the IMAGE parameter according to value in the Image Name box in the Additional Setting dialog box (page 22).

⚠️ Make sure that the WebCam_Viewer.class file is located in the same folder where your web page located. Otherwise web browser could not find the Java file.

### Java Applet Parameters

Java Applet displays captured images up to 20 frames per second. Unfortunately not all Web Browsers support Java Applets, and most of Pocket PCs don't have Java Engine.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BORDER</td>
<td>If value is &quot;ON&quot; applet draws frame around image. If value is &quot;OFF&quot;, applet just displays the captured image. Example: <code>&lt;PARAM NAME=&quot;BORDER&quot; VALUE=&quot;OFF&quot;&gt;</code></td>
</tr>
<tr>
<td>COLOR</td>
<td>Defines applet's background color. The color value is a six digit hexadecimal RGB specification preceded by the pound (#) sign. The first two digits indicate the red value, the second two digits indicate the green value, and the last two digits indicate the blue value. The range for each color value is 00 to FF inclusive. Modify the COLOR parameter according to the color of your web page. Example: <code>&lt;!-- red background --&gt;</code> <code>&lt;PARAM NAME=&quot;COLOR&quot; VALUE=&quot;#FF0000&quot;&gt;</code></td>
</tr>
<tr>
<td>FRAMEINTERVAL</td>
<td>Default frame rate in milliseconds. If there is not the ViewerParams.ini file, this parameter is used.</td>
</tr>
<tr>
<td>IMAGE</td>
<td>Defines file name of captured image, which is defined in the Image Name box. See</td>
</tr>
</tbody>
</table>
Displaying Still Images on Web Page

If you don't want to use the Java applet on your web page to display picture from camera you can configure the web page to refresh itself according frame rate.

This method doesn't need any special technologies like Java Engine and it works with any Web browser, but frame rate cannot be higher than 1 frame per second.

Use a tag like this to display the image:

```html
<img width=240 height=180 src="capture0.jpg">
```

Change the `SRC` parameter according to value in the `Image Name` box in the Additional Setting dialog box (page:22).

To refresh the image, add the following code into the `<Head>` section of your web page:

```html
<meta http-equiv="REFRESH" content="10">
```

This will cause Internet browser to refresh page every 10 seconds. Specify this value to the same as your broadcasting frame rate and your viewers will see an updated image right away when it has been captured.

Watching camera on PDA or Cell Phone

To watch camera on PDA or cell phone you have to have a PY Software account. To subscribe click the PY Software web services command from the Tools menu. See more information at the Streaming Video through Web Server topic (page 44).

First of all you need to activate Web Streaming.

To activate Web Streaming

- Click Broadcast Settings from the Settings menu.
- Click to select the Stream to Web server check box.

To watch camera on cell phone:

Type the http://<your_login_name>.web2cam.com address in your internet browser.

Motion Detection

The detecting motion module analyzes captured images and performs special tasks if a movement is detected. You can use motion detection to monitor your home, office, children, or pets. It alerts you if something moves or changes in the monitored area.
To configure Motion Detection, click **Motion Detection** from the **Settings** menu.

Click to select the **Motion Detection Enabled** check box to activate motion detection.

**Motion Detection Parameters**

**Motion Sensitivity** defines a value in percent of the changes. Large value means more sensitivity. You can check your settings with the bar below the sensitivity track bar: green - no motion event, red - there is a motion.

**Motion Detection Frequency**

Specify motion detection frequency from the **Check Motion Every** drop-down list.

**Motion Area**

You can specify an area of motion detection. Motion that occurs outside the area will not be detected. For example, you can use this feature if you want to remove cars moving outside the window.
To define Motion Area:

- Click the **Define Motion Area** button.
- Press and hold left mouse button and drag the mouse to draw a rectangular area that will be removed from motion detection.
- Repeat this until all unwanted motions are covered. Less observed area you specified, the motion will be detected more accurately.

**Warning Time** defines a delay in seconds before the program starts motion detection. Increase this value if your camera needs time to adjust focus and stabilize picture.

**Motion Actions**

When a motion is detected, the program performs the following actions:

**Start FTP Uploading when motion detected**
If a motion is detected, Active WebCam uploads images to FTP server.
If the **Stop FTP Uploading After** check box is checked, the uploading will be stopped after specified number of seconds past.

**Send Email**
Click to select the **Send Email** check box if you want to receive emails when motion detected.
Click the **Email Settings** button to customize the email parameters.

**Outgoing Mail Server**
This is the mail server that your email is sent through. If you are unsure of this setting, have a look at the settings of your E-Mail client and see what you have set for your SMTP server.

**Sender**
Enter your e-mail address.

**Recipient**
Enter the e-mail address of who will receive e-mail message. If there is few recipients, type the e-mail address of each recipient, separating addresses with a comma or semicolon (;).

**Subject**
Enter the subject of e-mail message.

**Message**
Enter contents of the message.
If you want to insert date and time in the email body or in the subject, it must be enclosed in the braces {}.
Like: {dd/mm/yyyy}.
For example the text:
Motion on {dd/mm/yyyy} at {hh:nn:ss} 
will be displayed as:
Motion on 10/08/2001 at 22:13:30

Please refer to the Time formatting macros topic (page 21) for more information.

**Do not send more than one email during XXX sec.**

Enter number of seconds, which specifies highest frequency of message sending.

**Attach Images to Email**
Click to select the Attach Images to Email check box if you want to include motion images in the e-mail.

**Message Priority**
Select the priority of e-mail message.

**Play Sound**
Click to select the Play Sound check box to make an alert sound when motion is detected.

**Launch a Program**
Click to select the Launch a Program check box to start a program when motion is detected.

**Record Video Clip**
Click to select the Record Video Clip check box to have the program record video file when motion is detected.

Specify the video clip length in the Record Duration box. If there was a motion during the recording time, the program continues recording. The recording stops if there was no motion during the Record Duration period.

Recorded video clip can be uploaded onto FTP server right after its creation. Click to select the FTP Upload check box if you want the recorded file will be uploaded to web server.

Click the FTP Settings button to set up FTP parameters. See more info in the FTP parameters topic (page 27).

**Pop-Up the Program Window**
Click to select the Pop-Up Program's Window check box if you want the program to be on the top of other programs when a motion has been detected. This feature can be useful in conjunction with a sound playing that you have a video reminder, which makes sound and pops up on the computer screen when somebody walks in front of your camera.

**Create Motion Snapshots**
Click to select the Create Snapshots check box if you want to have sequence of motion images.

Specify the snapshots duration in the Stop After box. If there was a motion during this time, the program doesn't stop the snapshots creation. The snapshots creation stops if there was no motion during this period of time.

Click the Additional Settings button to change the following parameters:

**File Name** - the program saves incrementally named JPEG snapshots under this name. Use the {COUNTER} tag in the file name as a place-holder for the counter value.
If you specify full path in the **File Name** box, snapshots are saved under this file name, otherwise they are saved in the **Gallery** folder.

**Frame Rate** - use this box to set the how many snapshots created per second, per minute, or per hour.

Click to select the **Reset counter** box if you want the counter to be set to the start value every time when new snapshots sequence begins.

The **Upload Snapshots** check box causes the program to upload snapshots to the FTP server. Click the **FTP Settings** button to set up FTP parameters. See more info in the **FTP parameters** topic (page 27).

Click to select the **When the snapshots creation starts, make new sub-folder** box if you want the program to create new sub-folder on the FTP server every time when new snapshots sequence begins. The folder name may include parameters like time: `{hh:nn}`, camera number: `{CAMERA}`, or current motion value: `{MOTION}` enclosed in the braces `{}`. See more info about parameters in the **Time formatting macros** topic (page 21).

In some cases it's necessary to change size of snapshots, for example to use them as thumbnails. Click to select the **Resize Snapshots** check box and enter the desired **width** and **height** in appropriate boxes.

**Change Settings**

This feature helps to save disk space by recording good quality video when there is motion and have poor quality and, as result, less disk space when there is no motion. Set the appropriate settings for video and sound quality when motion detected. These settings take place when motion detected. When the time period, defined in the **Set Settings back after** box, passes the program goes back to the settings defined in the **Compression** and in the **Recording** tabs.

**Send SMS Message**

To use this service you have to be subscribed on one of PY Software web services.

Please use the **PY Software web services (Dynamic IP Service)** command from the **Tools** menu to subscribe for this service. See more information at the **Streaming Video through Web Server** topic (page 44).

Click to select the **Send SMS Message** check box if you want to receive SMS messages when motion detected.

Click the **SMS Settings** button to customize the **SMS parameters**.

**Phone Number**

Enter a phone that SMS message will be sent to. It must be digits only with country code and area code (example: 14168315678). Up to 16 digits.

If there is few recipients, type the phone number of each recipient, separating addresses with semicolon ( ; ).

**Sender**

Enter your name or phone number. Up to 16 characters or digits.

**Do not send more than one message during** **XXX** **sec.**

Specify the interval of two sent-out messages. Any alert condition will be ignored during the interval.

**Message**

Enter contents of the message.

If you want to insert date and time in the SMS body or in the subject, it must be enclosed in the braces `{}`. Like: `{dd/mm/yyyy}`.

For example the text:

Motion on {dd/mm/yyyy} at {hh:nn:ss}
will be displayed as:

Motion on 10/08/2001 at 22:13:30

Please refer to the Time formatting macros topic (page 21) for more information.

**Schedule Events**

Active WebCam has a scheduler that performs tasks on specified day of week and time period. You can use this feature, for example, to start recording in the morning and stop it in the evening.

To schedule a task:

- Click **Scheduler** from the Tools menu.
- Click to select the **Enable Scheduler** check box to activate scheduled.
- Click the **Add** button to add new task.

The **Schedule** dialog box appears.

In the **Schedule** dialog box set the properties of schedule:

- Select camera from the **Camera** list, or select **All Cameras**.
- Select a day in the **Day of Week** drop-down list.
- Specify the start and end time in the **From** and **To** boxes.

Choose an action. Depends on what you have selected the program will perform different tasks like: broadcasting, recording, motion detection, etc.

**Recording** - the selected camera or all cameras start recording at scheduled time.

**Detecting Motion** - the selected camera or all cameras start motion detection at scheduled time.

**FTP Uploading** - the selected camera or all cameras start upload images to FTP server at scheduled time. The FTP settings must be specified in the Broadcasting tab in the Camera Settings window.

**Enabling Remote Access** - the selected camera or all cameras start to be enabled from remote computers at scheduled time.

**Running HTTP Server** - the selected camera or all cameras start HTTP server at scheduled time.

**Copying Captured Images to a folder** - the selected camera or all cameras start copying captured images into specified folder at scheduled time.
Creating Snapshots - the selected camera or all cameras start creating snapshots of captured images at scheduled time.

Streaming to Web server - the selected camera or all cameras start web streaming.

To customize a task:

- Click the Edit button to customize selected task.
- Click the Delete button to delete selected task.

Make sure that the system date and time for your computer are accurate. Active WebCam uses this information to start a scheduling. You can use the Date/Time option in Control Panel to update your computer's date and time.

Recording Video

You can use Active WebCam to record a stream of full-motion video and audio from your video and audio sources. The program has the following recording features: Live Recording, Archive Recording, and ability to create Archive of Snapshots.

With Live Recording the program records video and audio constantly in a temporary file that allows you pause, fast-forward, and rewind live video from camera at any time.

The Archive Recording is performed when user clicks the Record button. The video and audio content is streamed into a file on your hard disk.

Archive of Snapshots is a sequence of still images captured with a predefined time interval.

Recording Video Clip

To record a video clip, click Record Video Clip from the Tools menu.
To stop recording, click Record Video Clip again.
To see the list of recorded files, click Gallery from the View menu.
To play recorded file double click on it in the Gallery window.

Customizing Recording

To customize video recording, click Recording Settings from the Settings menu.
The Camera Settings window appears.

**Recording Frame Rate**

Use the Frame Rate box to set the number of frames per second for the video record. The Frame Rate value can be set from 1 to 30. How much you adjust this value should depend on the speed of computer’s processor and the type of video (high movement versus low movement) the computer is encoding. More frames used per second means that there are smaller changes between frames, which equates to smoother-looking video. The lower the number of frames per second means that there are fewer frames per second to display action, which equates to less smooth or even jerky video. The more frames per second that your computer has to encode, the harder the processor has to work.

**Monitoring available disk space**

In the Min. Disk Space box specify minimum available disk space when Active WebCam, to clean hard drive, deletes oldest files before record new one.

**Maximum size of video file**

In the Max. File Size box set the maximum size that video clip can be. When a video clip exceeds this size the program closes the file and opens new one.

**Live Recording**

If live recording is active the program records video and audio constantly on hard disk. At any moment you can rewind and playback recorded content. This process takes some CPU usage thus don’t use it on slow computer. The maximum duration of live content is controlled by the Max. File Size value.

Click to select the Enable Live Recording check box to activate live recording.

Specify temporary file name in the Temporary File box.

**Archive Recording**

The archive recording is performed when user clicks the Record button, or if a motion has been detected, or if the recording was scheduled at certain time, or the Record all the Time option is selected.

The recording is performed into files in a predefined folder. You can change this folder in the Folder for Archives box.

Also you can define how to name the video files in the File Name box. File name may include parameters like time: \{hh:mm\}, camera number: \{CAMERA\}, or index: \{COUNTER\} enclosed in the braces \{\}. Please refer to the Time formatting macros topic (page 21) for more information.

**Video Recording Formats**

Select recording video format from the File Format list. You can select the following video files formats:
AWLive (Own Video Format) is used in the Active WebCam program only. These video files can be played only on computers where Active WebCam is installed. In opposite of using standard video formats like AVI and MPEG, this video format provides encryption and password protection that all video and audio information in a password protected file is scrambled and the file can be played with a valid password only. Click the **AWLive Settings** button to select type of encryption.

AVI (Audio Video Interleave) format has been defined by Microsoft. The most common AVI problem: if viewer's computer doesn't have a codec to decode AVI file, it pops up an error message and doesn't show video. You can use the AVI format if you are sure that the viewer's computer has the appropriate codec to decode the AVI file. Click the **AVI Settings** button to select an AVI codec and its options. During playback, the video quality depends on the selected video codec and its quality setting. Experiment with each video codec and quality setting to obtain a satisfactory recording. The trade off of having better quality is bigger video file size.

MPEG is an ISO/IEC standard being developed by MPEG (Moving Picture Experts Group), for compressing sound and movie files into for downloading across the Internet. All modern Internet browsers support the MPEG format.

**Recording Sound with Video**

If the **Record Sound** check-box is selected, the recorded file will contain audio as well as video. This greatly increases the file size.

**Actions performed when video file reaches maximum size or there is not free space on hard drive**

When recording is active and file reaches its maximum size or free space on hard disk is less then minimum value the program stops recording. If you want the program to continue recording, click to select the **Create new file and continue recording when max. file size or min. disk space exceeds** check box. In this case the program closes video file and creates new one that recording is not stopped.

If the **Delete oldest file when min. disk space exceeds** check box checked the program, to have free space on hard drive, deletes oldest files before record new one.

**Uploading Recorded Video to FTP server**

Click to select the **FTP Upload Archives** check box to cause the program to upload recorded video files to FTP server right after its creation.

Click to select the **Rename uploaded file** check box and specify a file name, if you want the program to rename the uploaded file on FTP server. This option can be useful if you want to place a link to last recorded video file on your web page.

**How to play back video files from within Web Page**

To play-back recorded video files on web page a special code to run video player must be inserted into web page. Open your page in a text editor, for example Notepad, and add the following code:

**Code to play-back AWLive files:**

```xml
<OBJECT Name="Pl1" WIDTH="320" HEIGHT="240"
classid="CLSID:66D393D5-4D80-497C-9F4F-F3839E090202"
CODEBASE="http://www.pysoft.com/Downloads/WebCamPlayerOCX.cab#version=5,1,0,9"
standby="Loading PY Software player for AWLive files...">
<PARAM NAME="FileName" VALUE=" http://www.mysite.com/WebCamVideo.AWLive">
</OBJECT>
```

**Code to play-back AVI and MPEG files:**

---

Copyright PY Software, www.pysoft.com
Creating Archive of Snapshots

If you want the program to create archive of captured images, click to select the Create Snapshots All the Time check box.

Click the Snapshots Settings button to change the following parameters:

File Name - the program saves incrementally named JPEG snapshots under this name. Use the {COUNTER} tag in the file name as a place-holder for the counter value.

If you specify full path in the File Name box, snapshots are saved under this file name, otherwise they are saved in the Gallery folder.

Frame Rate - use this box to set the how many snapshots created per second, per minute, or per hour.

Click to select the Reset counter box if you want the counter to be set to the start value every time when new snapshots sequence begins.

The Upload Snapshots check box causes the program to upload snapshots to the FTP server. Click the FTP Settings button to set up FTP parameters. See more info in the FTP parameters topic (page 27).

Click to select the When the snapshots creation starts, make new sub-folder box if you want the program to create new sub-folder on the FTP server every time when new snapshots sequence begins. The folder name may include parameters like time: [hh:mm], camera number: {CAMERA}, or current motion value: {MOTION} enclosed in the braces {}. See more info about parameters in the Time formatting macros topic (page 21).

Modify the FileName and src parameters with full URL to video file.

Change the Width and Height parameters according the image size.
In some cases it's necessary to change size of snapshots, for example to use them as thumbnails. Click to select the **Resize Snapshots** check box and enter the desired **width** and **height** in appropriate boxes.

### Managing Program from Command-line

Active WebCam accepts commands from command-line. You can run the program with command-line parameters or send commands to the already launched program.

<table>
<thead>
<tr>
<th>Command-line Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/Q</td>
<td>Terminates an already launched Active WebCam. Example: <em>WebCam.exe /Q</em></td>
</tr>
<tr>
<td>/REMOTE_ON</td>
<td>Enables Remote Access. Example: <em>WebCam.exe /REMOTE_ON</em></td>
</tr>
<tr>
<td>/REMOTE_OFF</td>
<td>Disables Remote Access. Example: <em>WebCam.exe /REMOTE_OFF</em></td>
</tr>
<tr>
<td>/HTTP_ON</td>
<td>Starts HTTP Server. Example: <em>WebCam.exe /HTTP_ON</em></td>
</tr>
<tr>
<td>/HTTP_OFF</td>
<td>Stops HTTP Server. Example: <em>WebCam.exe /HTTP_OFF</em></td>
</tr>
<tr>
<td>/FTP_ON</td>
<td>Starts FTP Uploading. Example: <em>WebCam.exe /FTP_ON</em></td>
</tr>
<tr>
<td>/FTP_OFF</td>
<td>Stops FTP Uploading. Example: <em>WebCam.exe /FTP_OFF</em></td>
</tr>
<tr>
<td>/R_ON</td>
<td>Starts Recording. Example: <em>WebCam.exe /R_ON</em></td>
</tr>
<tr>
<td>/R_OFF</td>
<td>Stops Recording. Example: <em>WebCam.exe /R_OFF</em></td>
</tr>
<tr>
<td>/SNAPSHOTS_ON</td>
<td>Starts Snapshots Creation. Example: <em>WebCam.exe /SNAPSHOTS_ON</em></td>
</tr>
<tr>
<td>/SNAPSHOTS_OFF</td>
<td>Stops Snapshots Creation.</td>
</tr>
</tbody>
</table>
Example: `WebCam.exe /SNAPSHOTS_OFF`  

**/M_ON**  
Starts Motion Detection.  
Example: `WebCam.exe /M_ON`  

**/M_OFF**  
Stops Motion Detection.  
Example: `WebCam.exe /M_OFF`  

**/DEVICE**  
Causes program to select video device, which index is defined in the next parameter. First device has index 1.  
For example if there is the following list of video devices on your computer:  
Logitech USB video camera  
3Com PC Web Camera  
ATI TV Wonder  

To select "3Com PC Web Camera" the command line will be:  
`WebCam.exe /DEVICE 2`  

**/USE_VFW**  
Causes program to use Video for Windows.  
Example: `WebCam.exe /USE_VFW`  

**/USE_DS**  
Causes program to use DirectShow.  
Example: `WebCam.exe /USE_DS`  

**/CAM_NO**  
Causes program to make active a camera window, which index is defined in the next parameter. First camera window has index 1.  
For example to select 2-nd camera the command line will be:  
`WebCam.exe /CAM_NO 2`  

**/FULL_SCREEN**  
Causes program to operate in the “full screen” mode.  

You can place any number of parameters to command line in any sequence.  

**PY Software Web Services**  

At PY Software Web Services, we are dedicated to go beyond simple hosting by offering powerful value added services that empower our users with the tools to build own Internet surveillance system in no time with few clicks of mouse.  

**To sign up for PY Software Web Services:**  
- Click [PY Software Web Services](http://www.pysoft.com) from the Tools menu.  
- Click the Sign Up for Commercial Account button.
• Also you can point your Internet Browser at: http://my.activewebcam.com/subscriber.php to subscribe for these services.

Streaming Video through Web Server

This service helps to access video on surveillance computer through Internet even if this computer completely protected by firewall, it connects to our web server like any other Internet browser does and firewall doesn't mention this connection as restricted.

Another benefit of this service - unlike direct access to the surveillance computer when all viewers must share single internet connection, this service provides high frame-rate broadcasting to the unlimited auditory because broadcasting is performed from our web server through high speed broadband connection.

Please refer to the Stream to Web Server topic (page 23) to get information how to activate web streaming.

Dynamic IP Service

If you broadcast from your computer, you should provide your viewers with IP address of your computer. However, if you have a dial-up connection, DSL line, or cable modem, then IP address of your computer changes every time you connect.

To get rid of this problem you can use Dynamic IP Service, which gives your surveillance system a permanent address on the internet.

A special web address is reserved for you once you sign up for Dynamic IP service. This web address is based on a User ID, which you receive after signing up.

For example, if your User ID is billsmith, the Internet address of your surveillance computer is http://billsmith.web2cam.com/ip

Therefore, whenever IP address changes, you can access your surveillance system easily.

How does this service work?

• Active WebCam defines IP address of surveillance computer.
• Active WebCam sends the IP address of surveillance computer to the PY Software web server.
• PY Software web server updates own data base.
• A viewer to watch surveillance computer points Web browser to the PY Software web server (for example: http://billsmith.web2cam.com/ip).
• PY Software web server redirects Web browser to the surveillance computer.
• Web browser connects to surveillance computer and shows images from camera.

To activate Dynamic IP Service:

• Click PY Software Web Services (Dynamic IP Service) from the Options menu.
- Click to select the **Use Dynamic IP Service** check box.
- Click the **Ok** button.

**Dial-Up Internet Connection**

You don't need to use dial-up connection if you have permanent Internet connection such as, Cable Modem, DSL, ISDN, etc.

If the Dial-Up service is enabled, Active WebCam establishes a dial-up connection every time when it needs to upload captured image.

To install dial-up networking on your computer (if it is not already installed), click **Start | Settings | Control Panel**, select **Add/Remove Programs**, choose **Windows Setup**, double-click **Communications**, and select **Dial-Up Networking**.

**To use Dial Up service:**

In the Active WebCam program click **Dial Up Connection** from the **Tools** menu.

Click to select the **Use Dial Up Connection** check box.

**Connection**

Select name of dial-up connection from the **Connection** list. Click the **Create New Dial-Up Connection** button if you want to make a new dial-up connection.

**Disconnect after upload**

After uploading image Active WebCam is able to hang up the dial-up connection. This can be useful, if you have configured a large interval to upload images and don't want to stay connected all this time.

Click to select the **Disconnect when done** check box to hang up after uploading.

**Authentication**

If the **Use Default Dial-Up Authentication** check box is checked, Active WebCam uses saved by Windows user name, password, domain, and phone number. To specify your own user name, password, domain, and phone number, click to uncheck the **Use Default Dial-Up Authentication** check box.

**Computer's IP Address**

The program has tool to resolve computer's internal and external IP addresses. Internal IP address can be used to connect to the computer inside local area network. External IP address is used to connect to the computer
from Internet. Usually computer has different external and internal IP addresses, because external IP addresses is established by Internet service provider.

To see the internal and external IP addresses click Get Computer IP Address from the Tools menu.

Video Conversion

Video Conversion tool helps you edit video clips and convert them from AWLive format to AVI and MPEG files.

To edit video clip with Video Conversion tool:

- Click Edit Video Clips from the Tools menu.
- Specify the Source File Name in the appropriate box. It can be an AWLive file only. Other file formats are not acceptable.
- If you don't want to convert whole file, click to unselect the Convert Whole File button and set the first and last frames of the part to be converted.
- In the Destination File Name box type the file where conversion will be performed to.
- Select format of result file from the Destination Format list. If you want to protect a file with password (or remove password), select the AWLive as destination format and click the AWLive...
Settings button to enter the password. AVI and MPEG files cannot be password protected because these formats don't support such protection.

- Click the Format Settings button to customize parameters of selected video format. See more info in the Video Recording Formats topic (page 39).
- Click the Convert button to start conversion.

Video Conversion tool accepts commands from command-line:

<table>
<thead>
<tr>
<th>Command-line Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First Parameter</strong></td>
<td>Full path to source file.</td>
</tr>
<tr>
<td>Example:</td>
<td><code>ImageConvert.exe &quot;J:\Cam1.AWLive&quot;</code></td>
</tr>
<tr>
<td></td>
<td>This command places the &quot;J:\Cam1.AWLive&quot; value in the &quot;Source File Name&quot; box.</td>
</tr>
</tbody>
</table>

| **Second Parameter**   | Full path to destination file. |
| Example:               | `ImageConvert.exe "J:\Cam1.AWLive" "J:\1.AWLive"` |
|                        | This command converts the "J:\Cam1.AWLive" file to the "J:\1.AWLive" file. |

| **Third Parameter**    | Defines format of converted file. |
|                       | 1 – AWLive format. |
|                       | 2 – AVI format. |
|                       | 3 – MPEG format. |
| Example:               | `ImageConvert.exe "J:\Cam1.AWLive" "J:\1.avi" 2` |
|                        | This command converts the "J:\Cam1.AWLive" clip to the AVI file "J:\1.avi". |
Chapter 3

Troubleshooting

Questions and Answers

Question:
Why the camera screen is black?

Answer:
Make sure that your camera is turned on and properly connected. Also, try running other video applications to see if it is a problem with the camera. If so, contact the technical support of your camera vendor.

Question:
Camera screen is black but program, which came with camera, works. What is wrong?

Answer:
Check to ensure that your camera is Video for Windows compliant.

Question:
How can I make video screen brighter?

Answer:
Click Camera Settings from the Options menu. In the Camera Settings dialog box, change the brightness by clicking the Source button. For capture devices that do not provide a Video Source dialog box, the setting is probably in the Video Format dialog box.

Question:
How do I upload captured images?

Answer:
If you select Publishing Method - FTP upload, the program automatically connects to your FTP server and uploads captured images. See more info in the Upload Images to FTP server topic (page 27).

Question:
What does the Motion Sensitivity control do?

Answer:
This control determines what level of movement is required to trigger a motion action performing. The large value of sensitivity causes that the smaller changes in the image can start a motion action. Lover values decrease sensitivity, which result in more or larger changes without motion action performing.

Question:
Does the program needs a fixed connection?
**Answer:**
No, the program can use dial-up networking to automatically connect only when needed.

**Question:**
I'm AOL user. May I run the program on my AOL page?

**Answer:**
Only if you're using the AOL software for dial-up connections. Specific instructions can be found at: ftp://members.aol.com/usersFAQ.txt.

**Question:**
Visitors of my Web page can only see 1-2 frames per minute. What is the reason?

**Answer:**
Probably this is because of the narrow bandwidth of your or the visitor's network connection. Try to reduce the Image Quality and Publishing Frame Rate in the Camera Settings dialog box (page 18).

**Question:**
The program stops broadcasting after a long period of computer inactivity. What is wrong?

**Answer:**
This behaviour can occur if Advanced Power Management is enabled on the computer.
To work around this issue, turn off Advanced Power Management before you start the program. To do this, use the appropriate method for your operating system.

**Microsoft Windows 95**
To turn off Advanced Power Management:
Click Start, point to Settings, and then click Control Panel.
Double-click Power.
On the Power tab, click to unselect the Allow Windows to manage power use on this computer check box.
Click the Disk Drives tab.
Click to clear the When Powered By AC Power check box.
Click OK.

**Microsoft Windows 98, Microsoft Windows Millennium Edition (Me), or Microsoft Windows 2000**
To turn off Advanced Power Management:
Click Start, point to Settings, and then click Control Panel.
Double-click Power Management or Power Options.
On the Power Schemes tab, click Always On under Power schemes.
In the Turn off monitor box, click Never.
In the Turn off hard disks box (if available), click Never.
Click OK.

**Question:**
Captured image looks grainy or lacking color resolution.
Answer:

Make sure your system is set to display 24-bit or 32-bit color. 16-bit color is acceptable, although images won't show their true 24-bit color depth. 16-color (4-bit) and 256-color (8-bit) modes are unacceptable for image viewing and are not recommended.

To change color mode:

On the computer's screen click Start, point to Settings, and then click Control Panel.
Double-click Display.
Select Settings and change color depth.

Question:

I'm using firewall. Does the program upload images to FTP server through firewall?

Answer:

If you are using a firewall then you need to add an entry in to the allowed programs list/section to allow Active WebCam to connect to the Internet and upload captured images. If you are having problems uploading, then turn off the firewall and then try again, if the upload works, then you know that your firewall is blocking the connection some how. Read the firewalls documentation about adding a program to the allowed list.

Question:

Is there a way to incrementally name the image files, so that they can be saved as a series?

Answer:

The program can create archive of captured images. It can save an incrementally named copy of captured image in the images sub folder. See the Creating archive of captured images help topic for more info.

Question:

Can I watch recorded video on my web site?

Answer:

The program can upload recorded video files to FTP server, or copy to the HTTP server folder (if HTTP server is used for broadcasting). See more info in the Upload Images to FTP server topic (page 27).

Question:

I want to be able to set a limit on viewers; I also want to see their IP numbers.

Answer:

Number of viewers can be limited from the Camera Settings dialog box. See more info in the Remote Access using own HTTP Server topic (page 25). To cause program to log viewer's IP addresses, click to select Log HTTP viewers to the "HTTP_Log.txt" file from the Program Options dialog box (page 11).

Question:

When I try to play recorded video the movie is faster (2 or 3 times faster). Is there any solution to fix this problem?
**Answer:**
Probably the processor's speed is not enough to write video with selected frame rate. Try to use another video compression or reduce frame rate. See more info in the **Recording Video** topic (page 38).

**Question:**
Is possible to run more than one camera with the program?

**Answer:**
You can use simultaneous broadcasts from all cameras or single broadcasting with camera rotating. To broadcast from multiple devices simultaneously you need to create Camera Window for each camera. Every Camera Window has to have unique broadcasting port. See more info in the **Setting up Camera** topic (page 15).
If you want to use camera rotating, you need to create one Camera Window and enable **Camera Cycler**.

**Question:**
Sometimes my connection at home to my provider fails and then my computer gets a new IP address and there's the problem, when I'm somewhere else I cannot see what the new IP address is and then I cannot look at my camera anymore. How can I deal with this problem?

**Answer:**
To get rid of this problem you can use **Dynamic IP Service**, which gives your surveillance system a permanent address on the internet. See more info in the **Dynamic IP Service** topic (page 44).

**Question:**
When I broadcast from my PC I open the web page and see my broadcast only through my LAN, but on any other machine from Internet it will not connect. How to correct this problem?

**Answer:**
If your network uses firewall, make sure the port the program is streaming through and IP address of your computer must be open on the firewall.
Make sure that the address of your computer was written correctly. The URL for connecting to your web camera is **http://IPaddress:portnumber**. Where **IPaddress** is external address of your computer. You can obtain this address from by selecting **Get Computer IP address** from the **Tools** menu. The **portnumber** is the value, which is specified as HTTP server port. See more info in the **Remote Access using own HTTP Server** topic (page 25).
If external IP address changes constantly, there is no warranty that your viewers can watch your camera all the time. To get rid of this problem you can use **Dynamic IP Service**, which gives your web camera a permanent address on the internet. See more info in the **Dynamic IP Service** topic (page 44).
Also please use the "**Testing accessibility from Internet**" command from the "**Tools**" menu to find out the reason why your computer is not accessible from Internet.

**Question:**
How do I get rid of border around my camera?

**Answer:**
You can remove border around image from camera if you add the **BORDER** parameter in the **APPLET** tag on your Web Page. If value is "ON" applet draws frame around image. If value is "OFF", applet just displays the captured image. Open your Web page in Notepad and add the following string before </APPLET> tag: `<PARAM NAME="BORDER" VALUE="OFF">`
See more info in the **Java Applet Parameters** topic (page 31).
Question:
Every time we start the program there are errors: "not supported DIB format. Operation continues successfully". Can you inform us what 'DIB format' means?

Answer:
The DIB format means the format of image captured from camera. This message means the program could not decode captured image. If the program receives this message, it uses another method of image capturing and continues working successfully.

Question:
I have cable internet that can get up to 150kb a second but the movie from my camera is moving very slowly, why?

Answer:
Sometimes cable internet providers reduce bandwidth for outgoing traffic. Mostly the upload bandwidth is 10 - 15KBps, which means you can broadcast 2-3 fps only. Ask your ISP about the outgoing bandwidth increasing.

Question:
How to broadcast through LinkSys router?

Answer:
Connect to the router through web browser.
Select "Advanced" and select "Filters".
Select the "Forwarding" tab.
Set the broadcasting port in the "Service Port Range".
Select the protocol: "Both".
Set the IP Address of your computer in the IP Address box.
Now your router will forward all client requests to the specified port on your computer.

Question:
How to broadcast through D-Link router?

Answer:
Connect to the router through web browser.
Select the "Virtual Server" tab.
Enter the broadcasting port in the "Service Ports".
Set the IP Address of your computer in the "Server IP" box.
Check the "Enable" box and click "Apply".
Now your router will forward all client requests to the specified port on your computer.

Question:
How to broadcast through SMC router?
**Answer:**

Connect to the router through web browser.
Select the "Virtual Server" page.
Set the "Private IP" box.
Enter the broadcasting port in the "Private Port".
If you broadcast using the Remote Access method, select the UDP type. If you broadcast using the HTTP Server, select the TCP type.
Click "Enter".
Now your router will forward all client requests to the specified port on your computer.

**Question:** How to broadcast through **Microsoft router**?

**Answer:**

You need to configure persistent port forwarding on the Microsoft router.
Connect to the router through web browser to open the Base Station Management Tool.
Click "Security".
On the Security menu, click "Port Forwarding", and then click "Set up persistent port forwarding".
In the "Description" box, type a description of the server field. (This step is optional.)
In the "Inbound port" box, type the broadcasting port.
In the "Type" box, select the protocol (UDP or TCP) for the port. If you broadcast using the Remote Access method, select the UDP type. If you broadcast using the HTTP Server, select the TCP type.
In the "Private IP address" box, type the IP Address of your computer.
In the "Private port" box, type the broadcasting port.
Click Apply.
Now your router will forward all client requests to the specified port on your computer.

**Question:**

I can not watch camera on my computer, Web browser says that "Your browser isn't running the <APPLET> tag, for some reason". What's wrong?

**Answer:**

If your web page is configured to playback captured images using Java applet, the viewer's computers must have installed Java engine. Unfortunately not all computers, especially pocket computers, have pre installed Java engine, and not all Web Browsers support Java Applets. If your computer doesn't have Java Engine, you can install all necessary updates at: http://windowsupdate.microsoft.com
If there is no way to install Java Engine on the viewer's PC, you can configure your web page to show captured video as a still image. In this case the viewer's PC doesn't need any special technologies like Java Engine and this method works with any Web browser, but frame rate cannot be higher than 1 frame per second. See more info in the **Displaying Still Images on Web Page** topic (page 32).

**Question:**

My webpage keeps flashing "Off Line" for one second, then shows my cam for 5 seconds, then shows "Of Line" again. What's causing this?
Answer:
The program displays "Off Line" color bars when it didn't receive 5 frames in a row. Probably the frame rate is high for this bandwidth and viewer's computer doesn't receive all frames. Try to reduce frame rate according bandwidth.

Question:
I have set the Motion Detection to "Record a Video". A little box says Duration which I set to 60sec. However the recording does not stop at 60s.

Answer:
If there was a motion during the recording time, the program continues recording. The recording stops if there was no motion during the **Duration** period.

Question:
I want to record automatically all motion in a single file every day till maximum file size is reached. Is it possible?

Answer:
To have all motion events to be written to one file:
- In the "Recording" tab of "Camera Settings" box set the low recording frame rate, for example 1 frame per minute.
- Enable Motion Detection and click to select the "Change Settings" check box.
- In the "Motion" tab, set the "Recording Frame Rate" to higher frame rate, for example 10 frames per second.
- In the "Set Settings back after:" box, specify the motion duration, for example 10 seconds. That when this time passes the program goes back to the ordinary settings.
- In the "Motion" tab, make the "Record Video Clip" check box disabled.
- Start the recording by the "Record Video Clip" command or by Scheduler.
Now, the recording is performed with low frame rate all the time, but when motion is detected the frame rate is speeding up to 10 frames per second and drops again to one frame per minute after 10 seconds.

Question:
How to setup the program to record each camera to its own file on hard drive and create new file for each day?

Answer:
You can program this task using scheduler. Click **Scheduler** from the **Tools** menu. Select **Enable Scheduler** and click the **Add Scheduler** button. In the new schedule select **All Cameras, All Days** and set the **Work Period** from 12:00:00 AM to 11:59:00 PM. Select **Recording**. The new schedule task will create new file at midnight, write to it during the day and close this file before midnight.

Question:
How to have the files incremented by one like camera001.JPG then camera002.JPG, etc. uploaded to our web server?
Answer:
To produce incremented snapshots click to select the Archive of Snapshots check box in the Recording tab in the Camera Settings window. Click the Archive of Snapshots Settings button and specify the file name as: "camera{COUNTER}.JPG". Click to select the Upload Snapshots check box to cause the program to upload snapshots to the FTP server. Click the FTP Settings button to set up FTP parameters. See more info in the Creating Archive of Snapshots topic (page 41).

Question:
How to configure the program to upload motion detection images with integrated time stamp in its name?

Answer:
To upload time stamped images click to select the Create Snapshots check box in the Motion Detection window, click the Additional Settings button, and in the File Name box enter something like: Snapshot{hh`nn`ss}

Question:
How to reduce the CPU usage?

Answer:
To reduce CPU usage:
Set lower value in the Preview Frame Rate;
Set lower value in the Recording Frame Rate;
Make the Live Recording disabled;
Make Captions disabled;
Configure camera to produce smaller images;
Make the Motion Detection disabled.

Question:
What computer I would need to run 6 cameras?

Answer:
According to our statistics one 320x240 frame takes about 100 Mhz of CPU. This 100 Mhz are spending on taking image from camera, converting the image to BMP format, detecting motion, and drawing time stamp on it, after this converting image to JPEG image, writing it to the file and broadcast it to remote viewers. That if we want process video from one camera with 5 fps - we need a 500 Mhz computer. If you want to record 5 fps video from 6 cameras you need a computer with 3Ghz processor.

Question:
How to setup that email will be sent when motion is detected between 5:00 pm to 7:00 am everyday?

Answer:
Please do the following:
Open the "Camera Settings" window and make motion detection enabled.
Configure motion detection to send email alerts.
Click Ok in the "Camera Settings" window to save motion settings.
Open the "Camera Settings" window again and make motion detection disabled.
Click Ok in the "Camera Settings" window.
Place a task in scheduler to make motion detection enabled from 5:00 pm to 7:00 am.

**Question:**
I have capture card but the program does not see the card. What do I need to do?

**Answer:**
We have tested the program with a freeware driver that works with all capture cards based on CONEXANT 878a chip. Please follow instructions at the *Installing Capture Card or Frame Grabber* topic (page 8) to properly install and configure your capture card.

**Question:**
The program is running as "service", how to open it to make changes?

**Answer:**
The service process is running in another name space that it has own settings and should be configured independently. To pop-up the program started as service, run Active WebCam again (on the Window's Start menu, click Programs, then PY Software, then Active WebCam) and the program which is running as service will be activated.

**Question:**
What is recommended hardware configuration and hard disk required for one month recording from 5 cameras?

**Answer:**
You can calculate the hard drive size, CPU speed of required computer, and bandwidth required to watch cameras remotely at: http://www.pysoft.com/SysCalc.htm

**Question:**
Remote Access to my camera through Internet doesn't work. What's wrong?

**Answer:**
The remote access needs that both computers are accessible by UDP protocol from Internet. That means the routers on both sites must forward UDP traffic on those computers. Please refer to the "router configuration" section in the frequently asked questions.

**Question:**
I am using PICO2000 capture card and sometimes frame from one camera appearing on another camera momentarily. Is there an adjustment for this in the program?

**Answer:**
To get rid from the frames crossover please increase value in the "Drop the first" edit box in the "Device" tab in the "Camera Settings" window.

**Question:**
When I have the "Use authorization" checked and when I access the website the authorization window only comes up the first time after which it does not ask for authorization again. Is there something that can be changed to not allow this to happen?
Answer:
The program remembers viewers' IP addresses that viewers need to enter password just one time per session, however if you want the program to prompt for login when viewers reconnect to camera, please enable a parameter called "Disconnect viewer after NN seconds of inactivity" in the "HTTP server additional settings" window.

Question:
Is it possible at the end of the day produce an mpeg file?

Answer:
To produce mpeg file at the end of the day, you need to configure scheduler that it will start a recording in the morning and stop recording at the end of the day. To have MPEG file, the MPEG file format must be selected in the "Recording" tab in the "Camera Settings" window.

Question:
I cannot view my camera from Internet; my router blocks any access to my computer.

Answer:
If your network doesn't allow accessing your camera outside, you can configure Active WebCam to stream video feed to the PY Software server and watch your camera from the PY Software web site. This method doesn't require that the streaming computer is accessibly from Internet, and, because PY Software web server has broadband connection, this method provides high frame-rate broadcasting to the unlimited auditory. To activate Web Streaming:

Sign up for PY Software account. Click "PY Software Web Services" from the "Options" menu.
Click the "Sign Up for Free Trial Account" button to try this service for free during 30 days.
Click the "Sign Up for Permanent Account" button to sign up for this service for a long period of time.
Click "Broadcast Settings" from the "Settings" menu.
Click to select the "Stream to Web server" check box to activate video streaming.
To watch your camera, type the http://<loginname>.web2cam.com address in your internet browser.

Question:
What is required to record my CTTV cameras?

Answer:
You need a capture card which has to be installed into your computer. This card has BNC connectors to connect cameras and it is performing digitalization of video which comes from cameras. We provide top of the line, leading edge capture cards. Please point your Internet browser at:
where you will find capture cards tested with our software.

Question:
Program does not remember the camera setting using Microsoft WDM image capture.
Answer:

The problem is the Microsoft WDM driver doesn't provide ability to read its settings by third party software. Because Active WebCam cannot obtain the driver's settings it cannot remember them. The solution is to select "Direct Show" capture method in the "Device" tab.

Question:

When I connect second USB camera I get error message: "Can't add video capture filter into graph". What's wrong?

Answer:

Some device drivers don't allow capturing from more than one device simultaneously. Please ask the device manufacturer for such possibility.

Question:

What is the difference between Active WebCam and Argus DVR software?

Answer:

Argus DVR software has been designed for security hybrid platforms. It has web interface with the same look and functionality on the local and remote computers. Users have full control of the program through network that surveillance computer can be operated with no monitor, keyboard, and mouse connected. It performs "cyclic" recording that the "disk full" situation never occurs. The program has synchronized video playback for event analysis from multiple cameras simultaneously. Active WebCam provides scheduled, continuous or activated upon motion detection video recording. It shows unlimited number of cameras, through Internet or on-site. When the program detects motion in the monitored area, it sounds alarm, e-mails captured images, or records video clip. The program cannot be configured remotely, it doesn't have "cyclic" recording, it doesn't have synchronized video playback from multiple cameras.

Question:

I'm using "Stream to Web Server". How can I show camera on my web page?

Answer:

You can add stream from your web camera directly to your web page using <iframe> tag like this:

```html
<iframe src="http://YOUR_ID_HERE.web2cam.com/webpage.php?c=1&amp;b=1&amp;h=200&amp;w=300&amp;background=EEEEEE" height="320" width="480"></iframe>
```

Please use your login name instead of YOUR_ID_HERE in tag above. The only parameter you need is 'c', which indicates your camera number.

Parameters description:

- w - webcam picture width.
- h - webcam picture height.
- bg - background color. Default is blue color.
b or border - show/hide frame border with buttons. (1/0 or ON/OFF)

v=java - use Java Applet viewer instead of ActiveX (You need to activate Java Applet viewer first in your profile http://www.web2cam.com).